Read Me First

EAP Authentication Requires Matching 802.1x Protocol Drafts

Wireless client devices use Extensible Authentication Protocol (EAP) to log onto a network and generate
a dynamic, client-specific WEP key for the current logon session. If your wireless network uses WEP
without EAP, client devices use the static WEP keys entered in the Aironet Client Utilities.

If you use Network-EAP authentication on your wireless network, your client devices and access points
must usc the same 802.1x protocol draft. For example, if the radio firmware on the client devices that

will associate with an access point is 4.16, then the access point should be configured to use Draft 8 of
the 802.1x protocol. Table 1 lists firmware versions for Cisco Aironet products and the draft with which

they comply.

Table 1 802, 1x Protocol Drafts and Compliant Client Firmware

Firmware Version Draft7 |Draft8 |Draft10
PC/PCI cards 4.13 — X —_
PC/PCI cards 4.16 — X —
PC/PCI cards 4.23 — X —
PC/PCI cards 4.25 and later — — X
WGB34x/352 8.58 — X —
WGB34x/352 8.61 or later — — X
AP34x/35x 11.05 and ecarlier — X —
AP34x/35x 11.06 and later’ — X X
BR352 11.06 and later’ — X X

1. The defoult draft setting in access point and bridge firmware version 11.06

and later is Draft 10.
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Il EAP Authentication Requires Matching 802.1x Protocol Drafts

Step 1

Step 2

Step 3

Use the Authenticator Configuration page in access point and bridge firmware version 11.06 to select
the draft of the 802.1x protocol the access point or bridge's radio should use. Follow these steps to set
the draft for your access point of bridge:

Browse to the Authenticator Configuration page in the access point or bridge management system.
a. On the Summary Status page, click Setup.

b. On the Setup page, click Security.

¢. On the Security Setup page, click Authentication Server.

Use the 802.1x Protocol Version (for EAP authentication) pull-down menu to select the draft of the
802.1x protocol the access point or bridge's radio should use. Menu options include:

o Draft 7—No radio firmware versions compliant with Draft 7 have LEAP capability, so you
should not need to select this setting.

o Draft 8—Select this option if LEAP-enabled client devices that associate with this access point
or bridge use radio firmware versions 4.13, 4.16, or 4.23.

o Draft 10—This is the default setting in access point and bridge firmware versions 11.06 and
later. Select this option if client devices that associate with this access point or bridge use
Microsoft Windows XP EAP authentication or if LEAP-enabled client devices that associate
with this bridge use radio firmware version 4.25 or later.

Click Apply or OK to apply the setting. The access point or bridge reboots.
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Introduction

Cisco SYSTEMS

The Cisco Aironet 340 and 350 Series Wireless LAN Adapters, also referred to as client adapters, are
radio modules that provide transparent wireless data communications between fixed, portable, or mobile
devices and other wireless devices or a wired network infrastructure. The client adapters are fully
compatible when used in devices supporting Plug-and-Play (PnP) technology.

Corporate Headquarters: Cisco Systems, Inc., 170 Weat Tasman Drive, San Jose, CA 95134-1706 USA
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I System Requirements

The primary function of the client adapters is to transfer data packets transparently through the wireless
infrastructure. The adapters operate similarly to a standard network product except that the cable is
replaced with a radio connection. No special wireless networking functions are required, and all existing
applications that operate over a network will operate using the adapters.

This document applies to three types of client adapters:

¢ PC card client adapter (also referred to as a PC card)—A PCMCIA card radio module that can be
inserted into any device equipped with an external Type II or Type III PC card slot. Host devices
can include laptops, notebook computers, personal digital assistants, and hand-held or portable
devices.

* LM card client adapter (also referred to as an LM card)—A PCMCIA card radio module that can be
inserted into any device equipped with an internal Type II or Type III PC card slot. Host devices
usually include hand-held or portable devices.

e PClIclient adapter—A client adapter card radio module that can be inserted into any device equipped
with an empty PCI expansion slot, such as a desktop computer.

System Requirements

PC System
e Windows 95, 98, NT, 2000, or Me
e 486 (33-MHz) processor
e 16 MB RAM
* 39 MB free disk space
e VGA+ compatible display adapter
e 256 colors or at least 16 shades of gray
e 640 x 480 resolution monitor
e CD-ROM drive

Windows CE System
e Desktop PC with a CD-ROM drive and running Active Sync
e Serial or USB connection to Windows CE device

e Pocket PC (ppc) device with a StrongArm processor running Windows CE 3.0 or
hand-held (hpc) device with a Mips, SH3, SH4, StrongArm, or X86 processor running
Windows CE 2.11

Linux System
o Kernel version 2.2.xx
e 25 MB free disk space
e CD-ROM drive

Release Notes for Cisco Aironet Wireless LAN Adapters
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Installation Instructions

Macintosh System
e MacOS 9.x
* PowerPC processor
e 32 MBRAM
e 23 MB disk space
e 256 colors or 16 shades of gray
® 640 x 480 resolution monitor
e CD-ROM drive
e Open Transport Connectivity

Installation Instructions

Drivers

Note

Before you can configure and use your client adapter, you must install the latest driver and client utilities
and ensure that your adapter is using the latest firmware. Follow the instructions in the “Drivers,”
“Client Utilities,” and “Firmware” sections below to install the latest software.

The driver for your client adapter is provided on the Cisco Aironet Series Wireless LAN Adapters CD
that shipped with your product. The CD contains the following driver versions:

e  Windows 95, 98, NT, 2000, and Me (NDIS)—Cisco Aironet driver release 6.64
e Windows CE 2,11—Cisco Aironet driver release 1.4

e Windows CE 3.0—Cisco Aironet driver release 1.5

e Macintosh OS 9.x—Cisco Aironet driver release 1.0

e Linux—Cisco Aironet driver release 1.000.2

However, a more recent version of the driver may be available on Cisco.com.

When you install the driver for Windows CE, Linux, or Macintosh, the client utilities are
also installed. Therefore, Cisco recommends that you install the driver from Cisco.com
rather than the CD to ensure you use the latest version of both the driver and the client
utilities.

Follow the instructions in the “Installing the Driver” section below to install the latest driver (and client
utilities if your operating system is Windows CE, Linux, or Macintosh) from Cisco.com.

Installing the Driver

Step 1

Step 2

Follow the steps below to install the latest driver from Cisco.com.

Go to the following URL:
http://www.cisco.com/public/sw-center/sw-wireless.shtml

Under Cisco Aironet Drivers & Utilities, select your operating system.

[ 78-11296-02
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Il Instellation Instructions

Step 3

Step 4
Step 5
Step 6
Step 7

Click the driver file.

S

Note  There may be more than one driver file for Windows. Make sure you select the one
specific to your operating system.

Read and accept the terms and conditions of the Software License Agreement.
Select the Cisco server from which you wish to download the file.
Save the file to your computer’s hard drive or to a floppy disk; unzip the file.

Follow the instructions in the Cisco Aironet Wireless LAN Adapters Hardware Installation Guide
(provided on the CD) to install the driver for your specific operating system. As you follow the
instructions, keep in mind that you must access the driver file from your computer’s hard drive or a
floppy disk rather than from the CD as the instructions indicate.

Client Utilities

The utilities for your client adapter, which enable you to configure the adapter, are provided on the Cisco
Aironet Series Wireless LAN Adapters CD that shipped with your product. The CD contains the
following client utility versions:

e Version 4.13 for Windows [Aironet Client Utility (ACU), Client Encryption Manager (CEM), and
Link Status Meter (LSM)]

e Version 2:02 for Windows CE (ACU, CEM, Load New Firmware, Cisco Link Status, Client
Statistics Utility, Site Survey Tool, Cisco Aironet Uninstall)

e Version 1.4 (ACU), version 1.3 (CEM), and version 1.2 (bcard) for Linux
e Version 1.0 for Macintosh (pcm3x0PPC)
However, a more recent version of the client utilities may be available on Cisco.com:

e If your operating system is Windows 95, 98, NT, 2000, or Me, a more recent version of the client
utilities is available on Cisco.com. Follow the instructions in the “Installing the Client Utilities”
section below to install the latest version of the client utilities for Windows.

e If your operating system is Windows CE, Linux, or Macintosh and you installed the latest driver
from Cisco.com, the latest client utilities were installed along with the driver.

Installing the Client Utilities

Step 1

Step 2
Step 3
Step 4
Step 5

Follow the instructions below to install the latest version of the client utilities for Windows from
Cisco.com.

Use your web browser to access the following URL:
hitp://www.cisco.com/public/sw-center/sw-wireless.shtml

Under Cisco Aironet Drivers & Utilities, select For Windows.
Click ACUvxxxxxx.exe.
Read and accept the terms and conditions of the Software License Agreement.

Select the Cisco server from which you wish to download the file.

Release Notes for Cisco Aironet Wireless LAN Adapters
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Installation Instructions M

Step6  Save the file to your hard drive and unzip it.
Step7  Double-click setup.exe.

Step8  Follow the instructions in the “Install the Client Utilities” section of the Quick Start Guide: Clsco
Aironet Wireless LAN Adapters, beginning with Step 4.

Firmware

Your client adapter’s firmware is loaded into the adapter at the factory. However, a more recent version
of firmware may be available on Cisco.com. Follow the instructions in the subsections below to
determine the firmware version in your client adapter and on Cisco.com.

Determining the Current Firmware Version

To determine the firmware version that your client adapter is currently using, follow the instructions
below for your operating system.

In Windows 95, 98, NT, 2000, or Me

Select Status from the Commands pull-down menu in ACU. The firmware version is displayed in the
Status screen.

In Windows CE

Select Start > Programs > Cisco > Load New Firmware. The firmware version is displayed in the
Select New Firmware screen.

In Linux

Select Status from the Commands pull-down menu in ACU. The firmware version is displayed in the
Status screen.

In Macintosh

Select Status from the File pull-down menu in the Macintosh client utility and then the Link Status tab.
The firmware version is displayed in the Status screen,

Checking the Firmware Version on Cisco.com

Follow the instructions below to check the firmware version on Cisco.com.

Step1  Go to the following URL to view the latest firmware release for 340 and 350 series client adapters:
http://www.cisco.com/pcgi-bin/tablebuild.pl/aironet-340

Step2  Look at the file (PC340-350vxxx.exe) for the firmware image for 340 and 350 series radios. The
version number is indicated by xxx.

Release Notes for Cisco Aironet Wireless LAN Adapters
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I 1nstallation Instructions

Step 3

1f the firmware version number on Cisco.com is higher than the version currently in your client adapter,
follow the instructions in the “*Upgrading the Firmware” section below to upgrade to the latest version.

Upgrading the Firmware

Step 1

Step 2
Step 3
Step 4
Step 5

Step 6
Step 7

To upgrade your client adapter’s firmware, follow the instructions below.

Go to the following URL to access the latest version of firmware:
http://www.cisco.com/pcgi-bin/tablebuild.pl/aironet-340

Click PC340-350vxxx.exe to select the firmware image for 340 and 350 radios.
Read and accept the terms and conditions of the Software License Agreement.
Sclect the Cisco server from which you wish to download the file.

Save the file to your computer’s hard drive or to a floppy disk and unzip it.

~

Note  Ifyour computeris a Pocket PC (ppc) running Windows CE 3.0, you must copy the
firmware image to the My Documents folder or a folder under My Documents.

Make sure the client adapter is installed in your computer and is operational.

Follow the instructions in one of the subsections below for your specific operating system.

Windows 95, 98, NT, 2000, or Me

Step 1
Step 2
Step 3

Step 4

Windows CE

Step 1
Step 2
Step 3
Step 4

Step 5

In the Aironet Client Utility (ACU), select Load New Firmware from the Commands pull-down menu.
Find the location of the new firmware in the Open Window.

Click the new firmware image (PC340-350vxxx.img) so it appears in the File name box at the bottom
of the window.

Click OK to load the firmware image into your client adapter’s Flash memory.

Select Start > Programs > Cisco > Load New Firmware.
Click the Select Firmware button.
Find the location of the new firmware in the Open window.

Click the new firmware image (PC340-350vxxx.img) so it appears in the Name box at the bottom of
the window.

Click OK to load the firmware image into your client adapter's Flash memory.

Relense Notes for Cisco Aironet Wireless LAN Adapters
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Linux

Macintosh

Step 1
Step 2
Step 3

Step 4

Step 1
Step 2

Step 3
Step 4

New Foatures I

Sclect Load New Firmware from the Commands pull-down menu.
In the File Selection window, find the location of the new firmware in the Files box.

Under Files, click the new firmware image (PC340-350vxxx.img) so it appears in the Selection box at
the bottom of the window.

Click OK to load the firmware image into your client adapter’s Flash memory.

Sclect Load Firmware from the Edit pull-down menu.

In the Firmware window, select the location of the new firmware under Name (for example, Macintosh
HD).

Click the new firmware image (PC340-350vxxx.img).

Click the Open button to load the firmware image into your clicnt adapter’s Flash memory.

New Features

This section describes new features for the drivers, client utilities, and firmware used with the 340 and
350 series client adapters.

Drivers
New features for the 340 and 350 series client adapter drivers include:
e Support for Cisco Aironet 350 series radios
e Support for network security (server-based authentication)
e Macintosh support for Cisco Aironet PCI client adapters
Cisco Aironet 340 and 350 series PCI client adapters are supported for use with PowerMac G3 (Blue
and White) and G4 desktop computers. Driver package release 1.0.1 for Macintosh, which contains
PCI client adapter driver release 1.0, is the minimum version required to support this feature.
Release Notes for Cisco Aironet Wireless LAN Adapters
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I Now Features

Client Utilities

New features for the 340 and 350 series client utilities include:
* World Modc option

The client adapter scans for beacons and probe responses transmitted by the access point that contain
country information. The client uscs this information to set the frequency and transmit power levels
for the regulatory domain in which it is opcrating. Enable the World Mode feature by selecting the
World Mode checkbox in ACU or in the Macintosh pcm3x0PPC client utility.

Client firmware release 4.13 and access point firmware release 11.00 are the minimum versions
required for this feature.

e Scrver-based authentication

This feature leverages Cisco software and firmware so that your network logon triggers server-based
authentication using your name and password. The following limitations apply to this feature:

- Requires a LEAP-enabled RADIUS server on the network.

— Client firmware release 4.13 and access point firmware relcase 11.00 are the minimum versions
rcquired for this feature.

A

Note  Scrvcr-based authentication for Windows CE, Linux, and Macintosh is not ticd to
your network logon. Instead, the username and password used for server-based
authentication arc entered in one of the client utility screens or in a dialog box that
appears when LEAP is enabled. Also, Windows CE is the only operating system
in which the username and password are stored in the client adapter.

e Client logoff module (Windows only)

The Disassociate After Logoff (LEAP only) checkbox has been added to the Network Security
screen of ACU for Windows. Selecting this checkbox forces the client adapter to disassociate and
deauthenticate from the access point and RADIUS server when the user logs off, thereby preventing
someone else from logging in with the same privileges. This checkbox is available only if LEAP is
enabled. Cisco highly recommends that this option be enabled.

The following limitations apply to this feature:

—~ This feature is included in ACU version 4.14.001 and later and is available only for Windows
95, 98, NT, 2000, and Me.

- A LEAP-enabled RADIUS server must be on the network.

~ Client firmware release 4.13 and access point firmware releasc 11.00 are the minimum versions
required for this feature.

e Restart Card option (Windows and Macintosh only)

Whenever you disable LEAP, the client adapter is automatically reinitialized, causing the firmware
to load any saved WEP keys from Flash memory into RAM. This feature ensures that the client
adapter uses a WEP key that was set in the Client Encryption Manager (CEM) for Windows or in
the WEP Keys screen of the Macintosh client utility, instead of one assigned during LEAP
authentication, when LEAP is disabled, In addition, the Restart Card option has been added to the
Commands pull-down menu of ACU for Windows and to the File pull-down menu of the Macintosh
client utility. Selecting this option allows you to reinitialize the client adapter at any time.

ACU version 4.14.003 for Windows and Macintosh client utility version 1.0.1 are the minimum
versions required for this feature.

Release Notes for Cisco Aironet Wireless LAN Adapters



New Features M

dBm signal strength display option (Windows only)

ACU for Windows can display signal strength in dBm. From the Options menu, select Preferences
to configure how signal strength is displayed. In the Signal Strength Display Units box, select
Percent or dBm. The display units affect the Status, Linktest, and Site Survey screens as shown in
the table below.

Signal Strength Display
Units Selected Screens Display

Percent e Current signal strength
s Current beacons received or current signal quality

e Overall link quality

dBm e Current signal strength

e Current noise level

e Signal to noise ratio

This feature requires client firmware version 3.92 or later and is available only for Windows 95, 98,
NT, 2000, and Me.

Location manager module (Macintosh only)

Location manager is a feature of the Macintosh 9.x operating system that allows you to save a set
of preferences (or a location) for a specified application. This feature has been modified to allow
configuration settings for the client adapter to be saved so you can easily switch between
configurations for different locations (such as the office and home) without having to reset
individual configuration parameters. This feature, called the /location manager module, is installed
with the client utility and is available only for Macintosh computers.

Follow the instructions below to set up a location using this feature:
a. Sclect the apple icon in the menu bar.

b. Select Control Panels > Location Manager.

¢. Seclect File in the menu bar.

d. Select New Location and enter a name for the location in the Name New Location edit box.
Click Save.

e. In the Location Manager window, select Cisco Wireless LAN in the Settings menu and click
Apply.
f.  Select File in the menu bar and Save Location to save the current settings of the client adapter.

To switch locations, you can use the control strip in the bottom right-hand corner of the display or
follow the steps below:

a. Seclect the apple icon in the menu bar.
b. Seclect Control Panels > Location Manager.

c. Inthe Location Manager window, select the location to which you want to switch in the Current
Location menu. A message appears indicating that switching locations was successful. Click
OK.

I 78-11296-02
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™ Accessing Information on the Lotest Software Releases

Firmware

Accessing

New features for the 340 and 350 series client adapter firmware include:
* Support for Cisco Aironet 350 series radio hardware

¢ Server-based authentication (see explanation in the preceding “Client Utilities” section)

Information on the Latest Software Releases

Refer to the following documents on Cisco.com for a list and description of the open and resolved
caveats for specific software releases as well as information about new features and upgrade
instructions:

® Release Notes for Cisco Aironet Client Adapter Drivers
® Release Notes for Cisco Aironet Client Ultilities
® Release Notes jor Cisco Aironet Client Adapter Firmware

You can access these release notes at the following URL:
http://www.cisco.com/univercd/cc/td/doc/product/wireless/airo_350/350cards/pc350rn/index.htm

Getting Bug Information on Cisco.com

If you are a Cisco.com registered user, you can use the Cisco TAC Software Bug Toolkit, which consists
of three tools (Bug Navigator, Bug Watcher, and Search by Bug ID Number) that help you to identily
existing bugs (or caveats) in Cisco software products.

Access the TAC Software Bug Toolkit today at http://www.cisco.com/support/bugtools/.

Troubleshooting

For the most up-to-date, detailed troubleshooting information, refer to the Cisco TAC website at
http://www.cisco.com/tac. Select Wireless LAN under Top Issues.

Documentation Updates

This section describes changes and additions to the documents listed in the “Related Documentation”
section on page 14.

Viewing Current Link Speed in the ACU Status Screen

ACU's Status screen displays the real-time link speed of the client adapter only when packets are being
transmitted. When the client adapter is idle, the Status screen displays the link speed as 11 Mbps.

Rolenso Notes for Cisco Aironet Wireless LAN Adapters
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Documentation Updates

Use Site Survey Active Mode to Examine Link Speed

To examine real-time link speed for your client adapter, use active mode in ACU's site survey tool. In
passive mode, the link speed indicator reports the speed of echo packets and does not indicate real-time
link speed.

Enable Auto Configuration Switching Option Not Available

The Enable Auto Configuration Switching option, which is designed to enable the client adapter to
switch between an enterprise and home network configuration, is not yet available in ACU because the
latest driver (6.64) does not support it. This feature will be available in a future release of ACU.

Default Value for Use Short Radio Headers

In ACU’s RF Network screen, the default value for Use Short Radio Headers is Selected.

WepStat Icon Not Included in 6.64 Driver Release

The WepStat icon is not included in driver release 6.64 and, therefore, cannot be used to verify proper
installation of client adapter security options. (It looks like two connected computers and appears in the
Windows system tray when using driver version 6.10.)

Bcard Utility (Linux Only)

Bcard is an optional Linux-specific utility that reads a previously saved client adapter configuration
(which was set in ACU and CEM) from a file and configures additional client adapters using that
information. It is designed primarily for use in computer startup files to allow the computer to
reconfigure client adapters without user intervention.

Using Bcard and Server-Based Authentication

If you use server-based authentication (LEAP), the username and password are not stored in the
/etc/ethx.cfg file that becard uses to configure client adapters. Even though the client adapter may be
configured through bcard to associate to a LEAP-enabled access point, the client will not authenticate.
To authenticate, you must set the LEAP username and password in ACU.

Installing Beard

Beard is intended to be used by loading it from one of the startup files on your system. For example, on
a Red Hat 7.0 system, you could insert a command to load bcard in the /etc/rc.d/rc.local file. Assuming
that bcard was installed in /opt/cisco/bin, you would add /opt/cisco/bin/beard to /ete/re.d/re.local.

Release Notes for Cisco Aironet Wireless LAN Adapters
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M Documentation Updates

Macintosh Driver Support for PCI Client Adapters

Cisco Aironet PCI client adapters are supported for use with PowerMac G3 (Blue and White) and G4
desktop computers.

The instructions in the Cisco Aironet Wireless LAN Adapters Hardware Installation Gulde for installing
the driver for MacOS 9.x apply to both PC cards and PCI client adapters. However, the following
exceptions should be noted:

e Ifyouelect to do an easy install, the Macintosh installer loads the drivers for both PC cards and PCI
client adapters. If you elect to do a custom install, you must decide whether to install the driver for
PC cards or the driver for PCI client adapters.

* On PowerMac G3 computers, the PCI client adapter is referred to as “Ethernet slot JXX.”” On
PowerMac G4 computers, the PCI client adapter is referred to as “Ethernet slot SLOT XX.”

e To physically install a Cisco Aironet PCI client adapter in your PowerMac G3 or G4, follow the
instructions for installing a PCI expansion card in the user guide that accompanied your computer.
After the adapter is installed, follow the instructions in the Cisco Aironet Wireless LAN Adapters
Hardware Installation Guide to install the driver.

Mexico Channel Set Included in ETSI Regulatory Domain

Mexico is now included in the ETSI regulatory domain. However, only channels 9 through 13 can be
used in Mexico. Users are responsible for ensuring that the channel set configuration is in compliance
with the regulatory standards of Mexico.

Maximum Power Levels and Antenna Gains Per Regulatory Domain

An improper combination of power level and antenna gain can result in equivalent isotropic radiated
power (EIRP) above the amount allowed per regulatory domain. The following table indicates the
maximum power levels and antenna gains allowed for each regulatory domain.

Regulatory Domain Antenna Gain (dBi) Maximum Power Level (mW)
North America 0 100
(4 watts EIRP maximum) 2.2 100
5.2 100
6 100
8.5 100
12 100
13.5 100
21 5

Release Notes for Cisco Aironet Wireless LAN Adapters
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Regulatory Domain Antenna Gain (dBi) Maximum Power Level (mW)
ETSI 0 100
(100 mW EIRP maximum) 22 50
5.2 30
6 30
8.5 5
12 5
13.5 5
21 1
France/Singapore 0 100
(100 mW EIRP maximum) 2.2 50
5.2 30
6 30
8.5 5
12 5
13.5 5
21 1
Israel 0 100
(100 mW EIRP maximum) 2.2 50
5.2 30
6 30
8.5 5
12 5
13.5 5
21 1
Japan 0 50
(10 mW/MHz EIRP maximum) 22 30
5.2 30
6 30
8.5 n/a
12 n/a
13.5 5
21 n/a

Release Notes for Cisca Aironet Wireless LAN Adapters
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Related Documentation

For more information about Cisco Aironet client adapters, refer to the following publications:
e Quick Start Guide: Cisco Aironet Wireless LAN Adapters
s Cisco Aironet Wireless LAN Adapters Hardware Installation Gulde

o Cisco Aironet Wireless LAN Adapters Software Configuration Guide

Obtaining Documentation

The following sections provide sources for obtaining documentation from Cisco Systems.

World Wide Web

You can access the most current Cisco documentation on the World Wide Web at the following sites:
e http://www.cisco.com
e http://www-china.cisco.com

e hittp://www-europe.cisco.com

Documentation CD-ROM

Cisco documentation and additional literature are available in a CD-ROM package shipped separately
from the Cisco Aironet Series Wireless LAN Adapters CD that shipped with your product. The
Documentation CD-ROM is updated monthly and may be more current than printed documentation. The
CD-ROM package is available as a single unit or as an annual subscription.

Ordering Documentation

Cisco documentation is available in the following ways:

e Registered Cisco Direct Customers can order Cisco product documentation from the Networking
Products MarketPlace:

http://www.cisco.com/cgi-bin/order/order_root.pl

e Registered Cisco.com users can order the Documentation CD-ROM through the online Subscription
Store:

http://www.cisco.com/go/subscription

¢ Nonregistered Cisco.com users can order documentation through a local account representative by
calling Cisco corporate headquarters (California, USA) at 408 526-7208 or, in North America, by
calling 800 553-NETS(6387).
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Documentation Feedback

If you are reading Cisco product documentation on the World Wide Web, you can submit technical
comments electronically. Click Feedback in the toolbar and select Documentation. After you complete
the form, click Submit to send it to Cisco.

You can e-mail your comments to bug-doc@cisco.com.

To submit your comments by mail, use the response card behind the front cover of your document, or
write to the following address:

Attn Document Resource Connection
Cisco Systems, Inc.

170 West Tasman Drive

San Jose, CA 95134-9883

We appreciate your comments.

Getting Technical Assistance

Cisco.com

Cisco provides Cisco.com as a starting point for all technical assistance. Customers and partners can
obtain documentation, troubleshooting tips, and sample configurations from online tools. For Cisco.com
registered users, additional troubleshooting tools are available from the TAC website.

Cisco.com is the foundation of a suite of interactive, networked services that provides immediate, open
access to Cisco information and resources at anytime, from anywhere in the world. This highly
integrated Internet application is a powerful, easy-to-use tool for doing business with Cisco.

Cisco.com provides a broad range of features and services to help customers and partners streamline
business processes and improve productivity. Through Cisco.com, you can find information about Cisco
and our networking solutions, services, and programs. In addition, you can resolve technical issues with
online technical support, download and test software packages, and order Cisco learning materials and
merchandise. Valuable online skill assessment, training, and certification programs are also available.

Customers and partners can self-register on Cisco.com to obtain additional personalized information and
services. Registered users can order products, check on the status of an order, access technical support,
and view benefits specific to their relationships with Cisco.

To access Cisco.com, go to the following website:

http://www.cisco.com

Technical Assistance Center

The Cisco TAC website is available to all customers who need technical assistance with a Cisco product
or technology that is under warranty or covered by a maintenance contract.
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Contacting TAC by Using the Cisco TAC Webhsite

If you have a priority level 3 (P3) or priority level 4 (P4) problem, contact TAC by going to the TAC
website:

http://www.cisco.com/tac
P3 and P4 level problems are defined as follows:
e P3—Your network performance is degraded. Network functionality is noticeably impaired, but most
business operations continue.
* P4—You need information or assistance on Cisco product capabilities, product installation, or basic
product configuration.
In each of the above cases, use the Cisco TAC website to quickly find answers to your questions.
To register for Cisco.com, go to the following website:
http://www.cisco.com/register/
If you cannot resolve your technical issue by using the TAC online resources, Cisco.com registered users
can open a case online by using the TAC Case Open tool at the following website:

http://www.cisco.com/tac/caseopen

Contacting TAC by Telephone

If you have a priority level 1 (P1) or priority level 2 (P2) problem, contact TAC by telephone and
immediately open a case. To obtain a directory of toll-free numbers for your country, go to the following
website:

http://www.cisco.com/warp/public/687/Pirectory/DirTAC:shtml
P1 and P2 level problems are defined as follows:

e P1—Your production network is down, causing a critical impact to business operations if service is
not restored quickly. No workaround is available.

e P2—Your production network is severely degraded, affecting significant aspects of your business
operations. No workaround is available.

This document is 10 be used in conjunction with the documents listed in the “Related Documentation' scetion.
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